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Ghini is a suite of applications for managing botanical specimen collections.


	ghini.desktop lets you create and query a database representing objects and events in your plant collection.


	ghini.web publishes highlights from your database on the web.


	ghini.pocket puts a snapshot of your database in your handheld device.


	ghini.tour assists garden visitors with a map and spoken virtual panels.
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The bulk of this documentation focuses on ghini.desktop.  One final chapter
presents the rest of the Ghini family: ghini.pocket, ghini.web,
ghini.tour, and the data streams between software components.

All Ghini software is open [http://www.opensource.org] and free [http://www.fsf.org]. Our standalone software is released under the GNU
Public License [http://www.fsf.org/licensing/licenses/gpl.html]. Our
client-server software follows the GNU Affero Public License [http://www.fsf.org/licensing/licenses/agpl.html].
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Ghini's goals and highlights

Should you use this software? This question is for you to answer. We trust
that if you manage a botanic collection, you will find Ghini overly useful
and we hope that this page will convince you about it.

This page shows how Ghini makes software meet the needs of a botanic garden.

If you already know, and all you want is to do something practical, just  install the software, then check our user-contributed recipes.


Botanic Garden

According to the Wikipedia, »A botanic(al) garden is a garden dedicated to
the collection, cultivation and display of a wide range of plants labelled
with their botanical names«, and still according to the Wikipedia, »a
garden is a planned space, usually outdoors, set aside for the display,
cultivation, and enjoyment of plants and other forms of nature.«

So we have in a botanic garden both the physical space, the garden, as its
dynamic, the activities to which the garden is dedicated, activities which
makes us call the garden a botanic garden.
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the physical garden
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collection related activities in the garden





Botanic Garden Software

At the other end of our reasoning we have the application program Ghini, and
again quoting the Wikipedia, »an application program is a computer program
designed to perform a group of coordinated functions, tasks, or activities
for the benefit of the user«, or, in short, »designed to help people perform
an activity«.

Data and algorithms within Ghini have been designed to represent the
physical space and the dynamic of a botanic garden.
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core structure of Ghini's database



In the above figure, a simplified view on the database, the highlighted
blocks are those relative to objects you definitely need insert in the
database.

We distinguish three main sections in the database.  Start reading the graph
from the right hand side, with the relevant Taxonomy information, then
step to administering your Collection, and finally consider the physical
Garden.

The central element in Ghini's point of view is the Accession. Following
its links to other database objects lets us better understand the structure:

Accession links Planting to Species


An Accession represents the action of receiving this specific plant material in
the garden. As such, Accession is an abstract concept, it links
physical living Plantings —groups of plants placed each at a
Location in the garden— to the corresponding Species. It is not the same as an acquisition from a source, because in a single acquisition you can access material of more than one species. In other words: a single aquisition can embark multiple accessions. An
Accession has zero or more Plantings associated to it (0..n), and
it is at all times connected to exactly 1 Species. Each Planting
belongs to exactly one Accession, each Species may have multiple
Accessions relating to it.

An Accession stays in the database even if all of its Plantings
have been removed, sold, or have died. Identifying the Species of an
Accession consistently connects all its Plantings to the
Species.




Accession at the base of the history of your plants


Propagations and Contacts provide plant material for the garden;
this information is optional and smaller collectors might prefer to leave this aside.
A Propagation trial may be unsuccessful, most of the time it will result
in exactly one accession, but it may also produce slightly different taxa,
so the database allows for zero  or more Accessions per Propagation (0..n).
Also a Contact may provide zero or more Accessions (0..n).




Accession and Verification opinions


Specialists may formulate their opinion about the Species to which an
Accession belongs, by providing a Verification, signing it, and
stating the applicable level of confidence.




Accessing your own Propagations


If an Accession was obtained in the garden nursery from a successful
Propagation, the Propagation links the Accession and all of
its Plantings to a single parent Planting, the seed or the
vegetative parent.




Even after the above explanation, new users generally still ask why they
need pass through an Accession screen while all they want is to insert a
Plant in the collection, and again: what is this "accession" thing
anyway?  Most discussions on the net don't make the concept any clearer.
One of our users gave an example which I'm glad to include in Ghini's
documentation.


	use case:

	
	At the beginning of 2007 we got five seedlings of Heliconia
longa (a plant Species) from our neighbour (the
Contact source). Since it was the first acquisition of the
year, we named them 2007.0001 (we gave them a single unique
Accession code, with quantity 5) and we planted them all
together at one Location as a single Planting, also
with quantity 5.


	At the time of writing, nine years later, Accession
2007.0001 has 6 distinct Plantings, each at a different
Locations in our garden, obtained vegetatively (asexually)
from the original 5 plants. Our only intervention was
splitting, moving, and of course writing this information in
the database. Total plant quantity is above 40.


	New Plantings obtained by (assisted) sexual Propagation
come in our database under different Accession codes, where
our garden is the Contact source and where we know which of
our Plantings is the seed parent.








the above three cases translate into several short usage stories:


	activate the menu Insert → Accession, verify the existence and
correctness of the Species Heliconia longa, specify the initial
quantity of the Accession; add its Planting at the desired
Location.


	edit Planting to correct the amount of living plants — repeat this as
often as necessary.


	edit Planting to split it at separate Locations — this produces a
different Planting under the same Accession.


	edit Planting to add a (seed) Propagation.


	edit Planting to update the status of the Propagation.


	activate the menu Insert → Accession to associate an accession to a
successful Propagation trial; add the Planting at the desired
Location.




In particular the ability to split a Planting at several different
Locations and to keep all uniformly associated to one Species, or
the possibility to keep information about Plantings that have been
removed from the collection, help justify the presence of the Accession
abstraction level.



Hypersimplified view

People using Ghini only sporadically may prefer ignoring the database
structure and look at it as two nested sequences of objects, each element of
the sequence being necessary to add element at the next level.

In order to get down to an Accession, you will need four levels, as in this
example:


[image: _images/family-to-accession.png]

A quite complete set of Families and Genera are inserted in your database at
the moment Ghini initializes it. So all you need is adding Species and
Accessions, in this order.

When placing a physical Plant (relative to an Accession) somewhere in the
garden, you need to describe this "somewhere" digitally, as a Location in
the garden.
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Highlights

not-so-brief list of highlights, meant to whet your appetite.


taxonomic information

When you first start Ghini, and connect to a database, Ghini will
initialize the database not only with all tables it needs to run, but it
will also populate the taxon tables for ranks family and genus, using the
data from the “RBG Kew's Family and Genera list from Vascular Plant Families
and Genera compiled by R. K. Brummitt and published by the Royal Botanic
Gardens, Kew in 1992”.  In 2015 we have reviewed the data regarding the
Orchidaceae, using “Tropicos, botanical information system at the Missouri
Botanical Garden - www.tropicos.org” as a source.



importing data

Ghini will let you import any data you put in an intermediate json
format. What you import will complete what you already have in the
database. If you need help, you can ask some Ghini professional to help you
transform your data into Ghini's intermediate json format.



synonyms

Ghini will allow you define synonyms for species, genera, families. Also
this information can be represented in its intermediate json format and be
imported in an existing Ghini database.



scientific responsible

Ghini implements the concept of 'accession', intermediate between physical
plant (or a group thereof) and abstract taxon. Each accession can associate
the same plants to different taxa, if two taxonomists do not agree on the
identification: each taxonomist can have their say and do not need overwrite
each other's work. All verifications can be found back in the database, with
timestamp and signature.



helps off-line identification

Ghini allows you associate pictures to physical plants, this can help
recognize the plant in case a sticker is lost, or help taxonomic
identification if a taxonomist is not available at all times.



exports and reports

Ghini will let you export a report in whatever textual format you need. It
uses a powerful templating engine named 'mako', which will allow you export
the data in a selection to whatever format you need. Once installed, a
couple of examples are available in the mako subdirectory.



annotate your info

You can associate notes to plants, accessions, species, .... Notes can be
categorized and used in searches or reports.



garden or herbarium

Management of plant locations.



database history

All changes in the database is stored in the database, as history log. All
changes are 'signed' and time-stamped.  Ghini makes it easy to retrieve the
list of all changes in the last working day or week, or in any specific
period in the past.



simple and powerful search

Ghini allows you search the database using simple keywords, e.g.: the name
of the location or a genus name, or you can write more complex queries,
which do not reach the complexity of SQL but allow you a decent level of
detail localizing your data.



database agnostic

Ghini is not a database management system, so it does not reinvent the
wheel. It works storing its data in a SQL database, and it will connect to
any database management system which accepts a SQLAlchemy connector. This
means any reasonably modern database system and includes MySQL, PostgreSQL,
Oracle. It can also work with sqlite, which, for single user purposes is
quite sufficient and efficient. If you connect Ghini to a real database
system, you can consider making the database part of a LAMP system
(Linux-Apache-MySQL-Php) and include your live data on your institution web
site.



language agnostic

The program was born in English and all its technical and user documentation
is first written in that language. Both technical and user documentation use
gettext, an advanced tool for semi-automatic translation.

The program has been translated and can be used in various other languages,
including Spanish (97%), French (82%), Portuguese (71%), to name some
Southern American languages, as well as Ukrainian (100%) and Czech (71%).

Translation of documentation goes a bit slower, with only Ukrainian, Spanish
and Italian at more than 50%.



platform agnostic

Installing Ghini on Windows is an easy and linear process, it will not take
longer than 10 minutes. Ghini was born on Linux and installing it on ubuntu,
fedora or debian is consequently even easier. MacOSX being based on unix, it
is possible to successfully run the Linux installation procedure on any
recent Apple computer, after a few preparation steps.



easily updated

The installation process will produce an updatable installation, where
updating it will take less than one minute. Depending on the amount of
feedback we receive, we will produce updates every few days or once in a
while.



unit tested

Ghini is continuously and extensively unit tested, something that makes
regression of functionality close to impossible. Every update is
automatically quality checked, on the Travis Continuous Integration
service. Integration of TravisCI with the github platform will make it
difficult for us to release anything which has a single failing unit test.

Most changes and additions we make, come with some extra unit test, which
defines the behaviour and will make any undesired change easily visible.



customizable/extensible

Ghini is extensible through plugins and can be customized to suit the needs
of the institution.






          

      

      

    

 


  

    
      
          
            
  
Mission & Vision

Here we state who we are, what we think of our work, what you can expect of
this project.


Who is behind Ghini

Ghini is a small set of programs, meant to let collection managers manage
their collection also digitally.

Ghini was born back in 2004 as Bauble, at the Belize Botanical Garden. It
was later adapted to the needs of a few more gardens. Brett Adams, the
original programmer, made this software a commons, by releasing it under a
GPL license.

After years of stagnation Mario Frasca revived the project, and rebranded it
as Ghini in honour of Luca Ghini, founder of the first European botanic
garden and herbarium. Mario Frasca started advocating, travelling,
distributing, developing, expanding, redefining, documenting it, and it is
now Mario Frasca writing this, looking for users, requesting feedback.

Behind Ghini there's not only one developer, but a small but growing global
users community.

Translations are provided by volunteers who mostly stay behind the scenes,
translating missing terms or sentences, and disappearing again.

To make things clearer when we speak of Ghini, but should—and in this
document we will—indicate whether it's Ghini(the software), or Ghini(the
people), unless obviously we mean both things.



Mission

Our goal as Ghini Software is to provide free software, of proven quality,
and to let anybody install it if they feel like it.  We also aim at
facilitating access to functional knowledge, in the form of documentation or
by laying the contact among users or between users and software
professionals.

All our sources, software and documentation, are open and free, and we
welcome and stimulate people to use and to contribute.  To facilitate
community forming, all our platforms can be consulted without registration.
Registration is obviously required if you want to contribute.

Ghini welcomes the formation of groups of users, bundling forces to define
and finance further development, and we welcome developers contributing
software, from any corner in the world, and we stimulate and help them
comply with the high quality requirements, before we accept the contributed
code in the software sources.



Vision

The Vision serves to indicate the way ahead and projects a future image of
what we want our organization to be, in a realistic and attractive way.  It
serves as motivation because it visualizes the challenge and direction of
necessary changes in order to grow and prosper.


	by the year 2020


	reference point


	community


	development


	integration with web portal


	geographic information








          

      

      

    

 


  

    
      
          
            
  
Installation

ghini.desktop is a cross-platform program and it will run on unix machines
like GNU/Linux and MacOSX, as well as on Windows.


one-liner for hurried users.


Linux users just download and run the installation script [https://raw.githubusercontent.com/Ghini/ghini.desktop/ghini-1.0-dev/scripts/devinstall.sh].
You may read the documentation later.

Windows users in a real hurry don't the instructions and use a recent Windows installer [https://github.com/Ghini/ghini.desktop/releases/].  You do not miss any functional feature, but
you have less chances to contribute to development.

Mac users are never in a hurry, are they?
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Initial Configuration

After a successful installation, more complex organizations will need
configure their database, and configure Ghini according to their database
configuration. This page focuses on this task. If you don't know what this
is about, please do read the part relative to SQLite.


Should you SQLite?

Is this the first time you use Ghini, are you going to work in a
stand-alone setting, you have not the faintest idea how to manage a database
management system? If you answered yes to any of the previous, you probably
better stick with SQLite, the easy, fast, zero-administration file-based
database.

With SQLite, you do not need any preparation and you can continue with
connecting.

On the other hand, if you want to connect more than one bauble workstation
to the same database, or if you want to make your data available for other
clients, as could be a web server in a LAMP setting, you should consider
keeping your database in a database management system like PostgreSQL [http://www.postgresql.org] or MySQL/MariaDB [https://mariadb.org/],
both supported by Ghini.

When connecting to a database server as one of the above, you have to
manually do the following: Create at least one user; Create your database;
Give at least one user full permissions on your database; If you plan having
more database users: Give one of your users the CREATEROLE privilege;
Consider the user with the CREATEROLE privilege as a super-user, not
meant to handle data directly; Keep your super-user credentials in a very
safe place.

When this is done, Ghini will be able to proceed, creating the tables and
importing the default data set.  The process is database-dependent and it
falls beyond the scope of this manual.

If you already got the chills or sick at your stomach, no need to worry,
just stick with SQLite, you do not miss on features nor performance.


Some more hints if you need PostgreSQL


Start simple, don't do all at the same time. Review the online
manual [https://www.postgresql.org/docs/9.4/static/index.html], or
download and study the offline version [https://www.postgresql.org/files/documentation/pdf/9.4/postgresql-9.4-A4.pdf].

As said above, create a database, a user, make this user the owner of
the database, decide whether you're going to need multiple users, and
preferably reserve a user for database and normal user creation. This
super-user should be your only user with CREATEROLE
privilege.

All normal users will need all privileges on all tables and
sequences, something you can do from the
Tools‣Users menu.  If you have any difficulty,
please open an issue [https://github.com/Ghini/ghini.desktop/issues/new] about it.

Connect using the psql interactive terminal.  Create a
~/.pgpass file (read more about it in the manual [https://www.postgresql.org/docs/9.4/static/libpq-pgpass.html]),
tweak your pg_hba.conf and postgresql.conf files, until you
can connect using the command:

psql <mydb> --username <myuser> --no-password --host <mydbhost>





With the above setup, connecting from ghini will be an obvious task.
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Searching in Ghini

Searching allows you to view, browse and create reports from your
data. You can perform searches by either entering the queries in the
main search entry or by using the Query Builder to create the queries
for you. The results of Ghini searches are listed in the main window.


Search Strategies

Ghini offers four distinct search strategies:


	by value — in all domains;


	by expression — in a few implicit fields in one explicit domain;


	by query — in one domain;


	by binomial name — only searches the Species domain.




All search strategies —with the notable exception of the binomial name
search— are case insensitive.


Search by Value

Search by value is the simplest way to search. You enter one or more strings
and see what matches. The result includes objects of any type (domain) where
one or more of its fields contain one or more of the search strings.

You don't specify the search domain, all are included, nor do you indicate
which fields you want to match, this is implicit in the search domain.

The following table helps you understand the results and guides you in
formulating your searches.



	search domain overview



	name and shorthands

	field

	result type





	family, fam

	epithet (family)

	Family



	genus, gen

	epithet (genus)

	Genus



	species, sp

	epithet (sp) ×

	Species



	vernacular, common, vern

	name

	Species



	geography, geo

	name

	Geography



	accession, acc

	code

	Accession



	planting, plant

	code ×

	Plant



	location, loc

	code, name

	Location



	contact, person, org, source

	name

	Contact



	collection, col, coll

	locale

	Collection



	tag, tags

	name

	Tag






Examples of searching by value would be: Maxillaria, Acanth,
2008.1234, 2003.2.1, indica.

Unless explicitly quoted, spaces separate search strings. For example if you
search for Block 10 then Ghini will search for the strings Block and 10
and return all the results that match either of these strings. If you want
to search for Block 10 as one whole string then you should quote the string
like "Block 10".


× Composite Primary Keys


A species epithet means little without the corresponding
genus, likewise a planting code is unique only within
the accession to which it belongs.  In database theory
terminology, epithet and code are not sufficient to form a
primary key for respectively species and planting.
These domains need a composite primary key.

Search by value lets you look for plantings by their
complete planting code, which includes the accession code.
Taken together, Accession code and Planting code do provide
a composite primary key for plantings.  For species,
we have introduced the binomial search, described below.





  
    

    Editing and Inserting Data
    

    

    
 
  

    
      
          
            
  
Editing and Inserting Data

The main way that we add or change information in Ghini is by using
the editors.  Each basic type of data has its own editor.  For example
there is a Family editor, a Genus editor, an Accession editor, etc.

To create a new record click on the Insert menu on
the menubar and then select the type of record your would like to
create.  This opens a new blank editor for the type.

To edit an existing record in the database right click on an item in
the search results and select Edit from the popup
menu.  This opens an editor that allows you to change the
values on the record that you selected.

Most types also have children which you can add by right clicking on the
parent and selecting "Add ???..." on the context menu.  For example, a
Family has Genus children: you can add a Genus to a Family by right clicking
on a Family and selecting "Add genus".


Notes

Almost all of the editors in Ghini have a Notes tab which should work
the same regardless of which editor you are using.

If you enter a web address in a note then the link shows up in the
Links box when the item your are editing is selected in the search results.

You can browse the notes for an item in the database using the Notes
box at the bottom of the screen.  The Notes box is desensitized
if the selected item does not have any notes.



Family

The Family editor allows you to add or change a botanical family.

The Family field on the editor lets you change the epithet of the family.
The Family field is required.

The Qualifier field lets you change the family qualifier.  The value can
either be sensu lato, sensu stricto, or nothing.

Synonyms allow you to add other families that are synonyms with the family
you are currently editing.  To add a new synonyms type in a family name in
the entry.  You must select a family name from the list of completions.
Once you have selected a family name that you want to add as a synonym click
on the Add button next to the synonym list and the software adds the
selected synonym to the list.  To remove a synonym, select the synonym from
the list and click on the Remove button.

To cancel your changes without saving then click on the Cancel button.

To save the family you are working on then click OK.

To save the family you are working on and add a genus to it then click on
the Add Genera button.

To add another family when you are finished editing the current one
click on the Next button on the bottom.  This saves the current
family and opens a new blank family editor.



Genus

The Genus editor allows you to add or change a botanical genus.

The Family field on the genus editor allows you to choose the family
for the genus.  When you begin type a family name it will show a list
of families to choose from.  The family name must already exist in the
database before you can set it as the family for the genus.

The Genus field allows you to set the genus for this entry.

The Author field allows you to set the name or abbreviation of the
author(s) for the genus.

Synonyms allow you to add other genera that are synonyms with the
genus you are currently editing.  To add a new synonyms type in a
genus name in the entry.  You must select a genus name from the list
of completions.  Once you have selected a genus name that you want to
add as a synonym click on the Add button next to the synonym list and
it will add the selected synonym to the list.  To remove a synonym
select the synonym from the list and click on the Remove button.

To cancel your changes without saving then click on the Cancel button.

To save the genus you are working on then click OK.

To save the genus you are working on and add a species to it then click on
the Add Species button.

To add another genus when you are finished editing the current one
click on the Next button on the bottom.  This will save the current
genus and open a new blank genus editor.



Species/Taxon

For historical reasons called a species, but by this we mean a taxon at
rank species or lower.  It represents a unique name in the database.  The
species editor allows you to construct the name as well as associate
metadata with the taxon such as its distribution, synonyms and other
information.

The Infraspecific parts in the species editor allows you to specify
the taxon further than at species rank.

To cancel your changes without saving then click on the Cancel button.

To save the species you are working on then click OK.

To save the species you are working on and add an accession to it then click on
the Add Accession button.

To add another species when you are finished editing the current one
click on the Next button on the bottom.  This will save the current
species and open a new blank species editor.



Accessions

The Accession editor allows us to add an accession to a species.  In Ghini
an accession represents a group of plants or clones that are of the same
taxon, are of the same propagule type (or treatment), were received from the
same source, were received at the same time.

Choose the Taxon name, add one if you forgot to do that in advance.

You may note uncertainty in identification by adding an identification
qualifier, at the proper rank, so you can for example have a plant initially
identified as Iris cf. florentina by choosing Iris florentina in the
taxon name, identification qualifier 'cf.', qualified rank 'species'.

Type the Accession ID, preferably also the Quantity received.


Accession Source

The source of the accessions lets you add more information about where this
accession came from.  Select a Contact from the drop-down list, or choose
"Garden Propagation", which is placed as a default first item in the list of
contacts.

A Garden Propagation is the result of successful Propagation.

When accessing material from a Garden Propagation, you would initially leave
the first tab alone (General) and start from the second tab (Source).
Select as Contact "Garden Propagation", indicate which plant is the parent
plant and choose among the still not completely accessed propagations the
one you intend to add as an accession in your database.

Once you select a propagation, the software will set several fields in the
General tab, which you can now review.  The Taxon (maybe you managed to
obtain something slightly different than the parent plant). The Initial
quantity (in case not all plants go in the same accession). The Type of
Material, inferred from the propagation type.




Plant

A Plant in the Ghini database describes an individual plant in your
collection. A plant belongs to an accession, and it has a specific location.


Creating multiple plants

You can create multiple Plants by using ranges in the code entry.
This is only allowed when creating new plants and it is not possible
when editing existing Plants in the database.

For example the range, 3-5 will create plant with code 3,4,5.  The
range 1,4-7,25 will create plants with codes 1,4,5,6,7,25.

When you enter the range in the plant code entry the entry will turn
blue to indicate that you are now creating multiple plants.  Any
fields that are set while in this mode will be copied to all the
plants that are created.



Pictures

Just as almost all objects in the Ghini database can have Notes associated
to them, Plants and Species can also have Pictures: next to the tab for
Notes, the Plant and the Species editors contain an extra tab called
"Pictures". You can associate as many pictures as you might need to a plant
and to a species object.

When you associate a picture to an object, the file is copied in the
pictures folder, and a miniature (500x500) is generated and copied in the
thumbnails folder inside of the pictures folder.

As of Ghini-1.0.62, Pictures are not kept in the database. To ensure
pictures are available on all terminals where you have installed and
configured Ghini, you can use a network drive, or a file sharing service
like Tresorit or Dropbox.

Remember that you have configured the pictures root folder when you
specified the details of your database connection. Again, you should make
sure that the pictures root folder is shared with your file sharing service
of choice.

When a Plant or a Species in the current selection is highlighted, its
pictures are displayed in the pictures pane, the pane left of the
information pane. When an Accession in the selection is highlighted, any
picture associated to the plants in the highlighted accession are displayed
in the pictures pane.

In Ghini-1.0, pictures are special notes, with category "<picture>", and
text the path to the file, relative to the pictures root folder.  In the
Notes tab, Picture notes will show as normal notes, and you can edit them
without limitations.

A Plant is a physical object, so you associate to it pictures taken of that
individual plant, taken at any relevant development stage of the plant,
possibly helping its identification.

Species are abstract objects, so you would associate to it pictures showing
the characteristic elements of the species, so it makes sense to associate a
flora illustration to it. You can also do that by reference: go to the Notes
tab, add a note and specify as category "<picture>", then in the text field
you type the URL for the illustration of your choice.




Locations

The Location editor


danger zone

The location editor contains an initially hidden section named danger
zone. The widgets contained in this section allow the user to merge the
current location into a different location, letting the user correct
spelling mistakes or implement policy changes.
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Dealing with Propagations

Ghini offers the possibility to associate Propagations trials to Plants and
to document their treatments and results. Treatments are integral parts of
the description of a Propagation trial. If a Propagation trial is
successful, Ghini lets you associate it to a new Accession. You can only
associate one Accession to a Propagation Trial.

Here we describe how you use this part of the interface.


Creating a Propagation

A Propagation (trial) is obtained from a Plant. Ghini reflects this in its
interface: you select a plant, open the Plant Editor on it, activate the
Propagation Tab, click on Add.

When you do the above, you get a Propagation Editor window. Ghini does not
consider Propagation trials as independent entities. As a result, Ghini
treats the Propagation Editor as a special editor window, which you can only
reach from the Plant Editor.

For a new Propagation, you select the type of propagation (this becomes an
immutable property of the propagation) then insert the data describing it.

You will be able to edit the propagation data via the same path: select a
plant, open the Plant Editor, identify the propagation you want to edit,
click on the corresponding Edit button. You will be able to edit all
properties of an existing Propagation trial, except its type.

In the case of a seed propagation trial, you have a pollen parent, and a
seed parent. You should always associate the Propagation trial to the seed
parent.


注釈

In Ghini-1.0 you specify the pollen parent plant in the "Notes"
field, while Ghini-1.1 has a (relation) field for it. According to
ITF2, there might be cases in seed propagation trials where it is
not known which Plant plays which role. Again, in Ghini-1.0 you
should use a note to indicate whether this is the case, Ghini-1.1
has a (boolean) field indicating whether this is the case.
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Tagging

Tagging is an easy way to give context to an object or create a collection
of object that you want to recall later.

The power in this tagging action is that you can share this selection with
colleagues, who can act on it, without the need to redo all your collecting
work.

For example if you need to print accession labels of otherwise unrelated
plants, you can group the objects by tagging them with the string
"relabel". You or one of your colleagues can then select "relabel" from the
tags menu, the search view will show all the objects you tagged, and
performing a report will act on the tagged objects.

Tagging acts on the active selection, that is the items in the search
results which you have selected.

Please remember: you can select all result rows by pressing Ctrl-A, you can
deselect everything by pressing Ctrl-Shift-A, you can toggle tagging of a
single row by Ctrl-Mouse click on it.

Once you have an active selection, tagging can be done in two ways:


dialog box tagging

Press Ctrl-T or select Tag‣Tag Selection from the menu,
this activates a window where you can create new tags and apply any existing
tag to the selection.

The tag window is composed of three parts:


	The upper part mentions the list of objects in your active
selection. This is the list of object of which you are editing the tags;


	The middle part has a list of all available tags, with a checkbox that
you can activate for applying the tag to or removing the tag from the
selection;


	The lower part only holds a link to new tag creation, and the Ok button
for closing the dialog box.




If, when opening the tag dialog box, the active selection holds multiple
items, then only the tags that are common to all the selected items will
have a check next to it.  Tags that only apply to a proper subset of the
active selection will show with an 'undecided' status.  Tags that don't
apply to any object in the active selection will show blank.

The most recently created tag, or the most recently selected tag becomes the
active tag, and it shows with a check next to it in the tags menu.



windowless tagging

Once you have an active tag, pressing Ctrl-Y applies the active tag to all
objects in the active selection.  Ctrl-Shift-Y removes the active tag from
all objects in the active selection.
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Generating reports

A database without exporting facilities is of little use.  Ghini lets you
export your data in table format (open them in your spreadsheet editor of
choice), as labels (to be printed or engraved), as html pages or pdf or
postscript documents.


The Report Tool

You activate the Report Tool from the main menu: Tools‣Report.  The Report Tools acts on
a selection, so first select something, then start the Report Tool.


Report on the whole collection.


To produce a report on your whole plant collection, a shortcut would be from the home screen, to click
on the Families: in use cell.

If your focus is more on the garden location than on taxonomy and accessions, you would click on the
Locations: total cell.
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Importing and Exporting Data

Although Ghini can be extended through plugins to support alternate
import and export formats, by default it can only import and export
comma separated values files or CSV.

There is some support for exporting to the Access for Biological
Collections Data it is limited.

There is also limited support for exporting to an XML format that more
or less reflects exactly the tables and row of the database.

Exporting ABCD and XML will not be covered here.


警告

Importing files will most likely destroy any data you
have in the database so make sure you have backed up your data.


  
    

    Managing Users
    

    

    
 
  

    
      
          
            
  
Managing Users


注釈

The Ghini users plugin is only available on PostgreSQL
based databases.
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Contributed recipes collection

This page presents lists of use cases. If you're looking for straight,
practical information, you are at the right place. If you prefer a thorough
presentation of the software and database structure, check the section
software for botanical gardens

All material here has been contributed by gardens using the software and
sharing their experiences back to the user community.

The authors of the software wish to thank all dearly.


Quito Botanical Garden

At the JBQ, Quito Botanical Garden, we have adopted the Ghini software in
April 2015. Since that time, we have accumulated experience with the
program, and we are ourselves in need to document it, in order to secure the
knowledge to the institution. We are happy to share it.


Technical


	We work on GNU/Linux, a platform that many users don't master, and our
database is inside of a remote database management system. This implies
steps that are not obvious to the casual end user.


How to start a program


To start a program given its name, hit the [image: loose_png] key next to Alt, or
click on [image: 10000000000000300000002F89E0224ADF9EC09E_png], then start typing
the name of the program, in our case “Ghini” or just click on the program
symbol [image: 100000000000003100000031BB54CBDFA885EBAC_png], appearing near the
left margin of your display.
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Database Administration

If you are using a real DBMS to hold your botanic data, then you need do
something about database administration. While database administration is
far beyond the scope of this document, we make our users aware of it.


SQLite

SQLite is not what one would consider a real DBMS: each SQLite database is
just in one file. Make safety copies and you will be fine. If you don't know
where to look for your database files, consider that, per default, bauble
puts its data in the ~/.bauble/ directory.

In Windows it is somewhere in your AppData directory, most likely in
AppData\Roaming\Bauble. Do keep in mind that Windows does its best to
hide the AppData directory structure to normal users.

The fastest way to open it is with the file explorer: type %APPDATA% and
hit enter.



MySQL

Please refer to the official documentation [https://mariadb.com/kb/en/the-mariadb-library/documentation/].

Backing up and restoring databases is described in breadth and depth
starting at this page [https://mariadb.com/kb/en/the-mariadb-library/backing-up-and-restoring-databases/].



PostgreSQL

Please refer to the official documentation. A very thorough discussion of
your backup options starts at chapter 24 [http://www.postgresql.org/docs/9.1/static/backup.html].




Ghini Configuration

Ghini uses a configuration file to store values across invocations. This
file is associated to a user account and every user will have their own
configuration file.

To review the content of the Ghini configuration file, type :prefs in
the text entry area where you normally type your searches, then hit enter.

You normally do not need tweaking the configuration file, but you can do so
with a normal text editor program. Ghini configuration file is at the
default location for SQLite databases.



Reporting Errors

Should you notice anything unexpected in Ghini's behaviour, please consider
filing an issue on the Ghini development site.

Ghini development site can be accessed via the Help menu.
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the Ghini family

Let's start by recalling the composition of the Ghini family, as shown in the diagram:

[image: _images/ghini-family-clean.png]
You have learned how to use ghini.desktop, here we introduce the other
members of the family, and their interaction.


ghini.pocket

[image: _images/ghini-pocket-installed.png]
ghini.pocket is an Android app which you can install from the play
store [https://play.google.com/store/apps/details?id=me.ghini.pocket].
ghini.pocket is definitely the tool you will use most, next to
ghini.desktop.

With ghini.pocket you always have the latest snapshot of your
database with you.

Type an accession number, or scan its barcode or QR label, and you know:


	the identification of the plant,


	whether it already has pictures,


	when it entered the garden and


	from which source.




Apart as a quick data viewer, you can use ghini.pocket for...



data correction


If by your judgement, some of the information is incorrect, or if
the plant is flowering and you want to immediately take a picture
and store it in the database, you do not need take notes on paper,
nor follow convolute procedures: ghini.pocket lets you write your
corrections in a log file, take pictures associated to the plant,
and you will import this information straight into the database,
with further minimal user intervention.
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Developer's Manual

If you ran the devinstall installation instructions, you have downloaded
the sources, connected to the github repository.  You are in the ideal
situation to start looking into the software, understand how it works,
contribute to ghini.desktop's development.


Helping Ghini development

If you want to contribute to Ghini, you can do so in quite a few different ways:



	Use the software, note the things you don't like, open an issue [http://github.com/Ghini/ghini.desktop/issues/new] for each of them. A
developer will react sooner than you can imagine.


	If you have an idea of what you miss in the software but can't quite
formalize it into separate issues, you could consider hiring a
professional. This is the best way to make sure that something happens
quickly on Ghini. Do make sure the developer opens issues and publishes
their contribution on github.


	Translate! Any help with translations will be welcome, so please do! you
can do this without installing anything on your computer, just using the
on-line translation service offered by http://hosted.weblate.org/


	fork the respository, choose an issue, solve it, open a pull request. See
the bug solving workflow below.







If you haven't yet installed Ghini, and want to have a look at its code
history, you can open our github project page [http://github.com/Ghini/ghini.desktop] and see all that has been going on
around Ghini since its inception as Bauble, back in the year 2004.

If you install the software according to the devinstall instructions,
you have the whole history in your local git clone.



Software source, versions, branches

If you want a particular version of Ghini, we release and maintain versions
as branches. You should git checkout the branch corresponding to the
version of your choice.


production line

Branch names for Ghini stable (production) versions are of the form
ghini-x.y (eg: ghini-1.0); branch names where Ghini testing versions are
published are of the form ghini-x.y-dev (eg: ghini-1.0-dev).




Development Workflow

Our workflow is to continuously commit to the testing branch, to often push
them to github, to let travis-ci and coveralls.io check the quality of the
pushed testing branches, finally, from time to time, to merge the testing
branch into the corresponding release.

When working at larger issues, which seem to take longer than a couple of
days, I might open a branch associated to the issue. I don't do this very
often.


larger issues

When facing a single larger issue, create a branch tag at the tip of a main
development line (e.g.: ghini-1.0-dev), and follow the workflow
described at

https://git-scm.com/book/en/v2/Git-Branching-Basic-Branching-and-Merging

in short:

git up
git checkout -b issue-xxxx
git push origin issue-xxxx





Work on the new temporary branch. When ready, go to github, merge the branch
with the main development line from which you branched, solve conflicts
where necessary, delete the temporary branch.

When ready for publication, merge the development line into the
corresponding production line.




Updating the set of translatable strings

From time to time, during the process of updating the software, you will be
adding or modifying strings in the python sources, in the documentation, in
the glade sources. Most of our strings are translatable, and are offered to
weblate for people to contribute, in the form of several .po files.

A po is mostly composed of pairs of text portions, original and
translation, and is specific to a target language. When a translator adds a
translation on weblate, this reaches our repository on github. When a
programmer adds a string to the software, this reaches weblate as "to be
translated".

Weblate hosts the Ghini [https://hosted.weblate.org/projects/ghini/]
project. Within this project we have components, each of which corresponds
to a branch of a repository on github. Each component accepts translations
in several languages.



	component

	repository

	branch





	Desktop 1.0

	ghini.desktop

	ghini-1.0-dev



	Desktop 3.1

	ghini.desktop

	ghini-3.1-dev



	Documentation 1.0

	ghini.desktop-docs.i18n

	ghini-1.0-dev



	Documentation 3.1

	ghini.desktop-docs.i18n

	ghini-3.1-dev



	Web 1.2

	ghini.web

	master



	Pocket

	ghini.pocket

	master



	Tour

	ghini.tour

	master






To update the po files relative to the software, you set the working
directory to the root of your checkout of ghini.desktop, and you run the
script:

./scripts/i18n.sh





To update the po files relative to the documentation, you set the
working directory to the root of your checkout of ghini.desktop-docs.i18n,
and you run the script:

./doc/runme.sh





When you run either of the above mentioned scripts, chances are you need to
commit all po files in the project. You may want to review the changes
before committing them to the respository. This is most important when you
perform a marginal correction to a string, like removing a typo.

Something that happens: running into a conflict. Solving conflicts is not
difficult once you know how to do that. First of all, add weblate as remote:

git remote add weblate-doc10 https://hosted.weblate.org/git/ghini/documentation-10/





Then make sure we are in the correct repository, on the correct branch,
update the remote, merge with it:

git checkout ghini-1.0-dev
git remote update
git merge weblate-doc10/ghini-1.0-dev





Our documentation [https://readthedocs.org/projects/ghini/] on
readthedocs has an original English version, and several translations. We
just follow the description of localisation [http://docs.readthedocs.io/en/latest/localization.html], there's nothing
that we invented ourselves here.

Readthedocs checks the project's Language setting, and invokes
sphinx-intl to produce the formatted documentation in the target
language. With the default configuration —which we did not alter—
sphinx-intl expects one po file per source document, named as the
source document, and that they all reside in the directory
local/$(LANG)/LC_MESSAGES/.

On the other hand, Weblate (and ourselves) prefers a single po file per
language, and keeps them all in the same /po directory, just as we do
for the software project: /po/$(LANG).po.

In order not to repeat information, and to let both systems work their
natural way, we have two sets of symbolic links (git honors them).

To summarise: when a file in the documentation is updated, the runme.sh
script will:


	copy the rst files from the software to the documentation;


	create a new pot file for each of the documentation files;


	merge all pot files into one doc.pot;


	use the updated doc.pot to update all doc.po files (one per language);


	create all symbolic links:


	those expected by sphinx-intl in /local/$(LANG)/LC_MESSAGES/


	those used by weblate in /po/$(LANG).po








We could definitely write the above in a Makefile, or even better include it
in /doc/Makefile. Who knows, maybe we will do that.



Producing the docs locally

The above description is about how we help external sites produce our
documentation so that it is online for all to see.  But what if you want to
have the documentation locally, for example if you want to edit and review
before pushing your commits to the cloud?

In order to run sphinx locally, you need to install it within the same
virtual environment as ghini, and to install it there, you need to have a
sphinx version whose dependencies don not conflict with ghini.desktop's
dependecies.

What we do to keep this in order?

We state this extra dependency in the setup.py file, as an
extras_require entry.  Create and activate the virtual environment, then
run easy_install ghini.desktop[docs].  This gets you the sphinx version
as declared in the setup.py file.

If all you want is the html documentation built locally, run ./setup.py
install docs.  For more options, enter the doc directory and run
make.



Which way do the translated strings reach our users?

A new translator asked the question, adding: »Is this an automated process
from Weblate --> GIT --> Ghini Desktop installed on users computers, or does
this require manual steps?

The aswer is that the whole interaction is quite complex, and it depends on
the component.

When you install ghini.desktop or one of the Android apps, the
installation doesn't assume a specific run-time language: a user can change
their language configuration any time.  So what we do is to install the
software in English together with a translation table from English to
whatever else.

At run-time the GUI libraries (Android or GTK) know where to look for the
translation strings.  These translation tables are generated during the
installation or upgrade process, based on the strings you see on Weblate.

The path followed by translations is: You edit strings on Weblate, Weblate
keeps accumulating them until you are done, or you don't interact with
Weblate for a longer while; Weblate pushes the strings to github, directly
into the development line ghini-1.0-dev; I see them and I might blindly
trust or prefer to review them, maybe I look them up in wikipedia or get
them translated back to Italian, Spanish or English by some automatic
translation service; sometimes I need to solve conflicts arising because of
changed context, not too often fortunately.  As said, this lands in the
development line ghini-1.0-dev, which I regularly publish to the
production line ghini-1.0, and this is the moment when the new
translations finally make it to the distributed software.

Users will notice a new version available warning and can decide to ignore
it, or to update.

For ghini.pocket, it is similar, but the notification is handled by the
Android system.  We publish on the Play Store, and depending on your
settings, your phone will update the software automatically, or only notify
you, or do nothing.  It depends on how you configured automatic updates.

For ghini.web, we haven't yet defined how to distribute it.

For ghini's documentation, it's completely automatic, and all is handled by
readthedocs.org.



Adding missing unit tests

If you are interested contributing to development of Ghini, a good way to
do so would be by helping us finding and writing the missing unit tests.

A well tested function is one whose behaviour you cannot change without
breaking at least one unit test.

We all agree that in theory theory and practice match perfectly and that one
first writes the tests, then implements the function. In practice, however,
practice does not match theory and we have been writing tests after writing
and even publishing the functions.

This section describes the process of adding unit tests for
bauble.plugins.plants.family.remove_callback.


What to test

First of all, open the coverage report index, and choose a file with low
coverage.

For this example, run in October 2015, we landed on
bauble.plugins.plants.family, at 33%.

https://coveralls.io/builds/3741152/source?filename=bauble%2Fplugins%2Fplants%2Ffamily.py

The first two functions which need tests, edit_callback and
add_genera_callback, include creation and activation of an object
relying on a custom dialog box. We should really first write unit tests for
that class, then come back here.

The next function, remove_callback, also activates a couple of dialog
and message boxes, but in the form of invoking a function requesting user
input via yes-no-ok boxes. These functions we can easily replace with a
function mocking the behaviour.



how to test

So, having decided what to describe in unit test, we look at the code and we
see it needs discriminate a couple of cases:


	parameter correctness

	
	the list of families has no elements.


	the list of families has more than one element.


	the list of families has exactly one element.






	cascade

	
	the family has no genera


	the family has one or more genera






	confirm

	
	the user confirms deletion


	the user does not confirm deletion






	deleting

	
	all goes well when deleting the family


	there is some error while deleting the family








I decide I will only focus on the cascade and the confirm
aspects. Two binary questions: 4 cases.



where to put the tests

Locate the test script and choose the class where to put the extra unit tests.

https://coveralls.io/builds/3741152/source?filename=bauble%2Fplugins%2Fplants%2Ftest.py#L273


what about skipped tests


The FamilyTests class contains a skipped test, implementing
it will be quite a bit of work because we need rewrite the
FamilyEditorPresenter, separate it from the FamilyEditorView and
reconsider what to do with the FamilyEditor class, which I think
should be removed and replaced with a single function.
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Template Letters

The reader getting to this point in the documentation probably understood that this Ghini project is
above all a very open and collaborative project.

Here in this page you find some template letters, used to welcome new users, or that you can correct,
print, and go with it to a garden, and propose them to adopt Ghini, or share with a group of your
local friends, so you can make Ghini become a (voluntary, or paid) part-time job for you.


Dear conservator or scientist,

You are reading Ghini's presentation letter. Ghini is a libre software project on GitHub,
focusing on botany. Brought to you by a small community of coders, botanists,
translators, and supported by a few institutions around the world, among which,
gardens that have adopted it for all their collection management needs.

The Ghini family is a software suite composed of standalone programs, data servers and
handheld clients, for data management, and publication:

[image: _images/ghini-family-streams.png]

	Ghini's core, ghini.desktop, lets you


	enter and correct your data


	navigate its links,


	produce reports


	import and or export using several standard or ad-hoc formats


	review your taxonomy using online sources




all according best practices suggested by top gardens, formalized in
standard formats like ABCD, ITF2, but also as elaborated by our
developers, based on the feedback of Ghini users.

ghini.desktop is developed and continously tested on GNU/Linux, but
runs equally well on Windows, or OSX. [1]



	ghini.pocket is your full time garden companion, an Android app
installed from the Play Store,


	assisting you in collecting or correcting data while in the field,


	associate pictures to your plants, and verify taxonomic information.


	Import your collected data into the desktop client when back in the office,




ghini.pocket reduces the time spent in front of your desktop PC to a true minimum.



	ghini.web is a web server and a courtesy data hub service, offering you
world wide visibility: Export a selection of your data from your desktop database, and
handle it for publication to the Ghini project, and we will include it at
http://gardens.ghini.me/, at no cost while we're able to do that, or for a guaranteed
minimal amount of time if you are able to support our hosting costs. ghini.web serves
a world map to help locate participating gardens, and within each garden, its contributed
georeferenced plants.


	ghini.tour, a geographic tour Android app aimed at visitors, using
OpenStreetMap as a base map, retrieving its data, gardens and virtual
panels, from the web data aggregator ghini.web.




All software within the Ghini family is either licensed GNU Public License v2+ or v3+.
It is a strong copyleft license.  In short, the GPL translates
the ethical scientific need to share knowledge, into legal terms. If you want to read more
about it, please refer to https://www.gnu.org/licenses/copyleft.html

Ghini's idea about knowledge and software ownership is that software is procedural knowledge
and as such, should be made a "commons": With software as a commons, "libre software" and
more specifically "Copylefted software", you not only get the source code, you receive the
right to adapt it, and the invitation to study and learn from it, and to share it, both share
forward to colleagues, and share back to the source.  With proprietary software, you are
buying your own ignorance, and with that, your dependency.

This fancy term "copyleft" instead of just "libre software", means the software you received
is libre software with one extra freedom, guaranteeing every right you were granted
upon receiving the software is never lost.

With copylefted software you are free —actually welcome— to employ local software developers
in your neighbourhood to alter the software according to your needs, please do this on
GitHub, fork the code, develop just as openly as the common practice within Ghini, and
whenever you want, open a pull request so your edits can be considered for inclusion in the
main branch. Ghini is mostly continuously unit tested, so before your code is added to the
main branch, it should follow our quality guidelines for contributions. With libre software you
acquire freedom and contribute to it, something that earns you visibility: Your additions stays
yours, you share them back to the community, and will see them completed and made better by
others. Having your code added to the main branch simplifies your upgrade procedure.

You can also contribute to the software by helping translate it into your native language. [5]

Some videos are published on YouTube, highlighting some of the software capabilities. [6]

Share back with the community. Several developers have spent cumulatively many thousand hours
developing this software, and we're sharing with the community.
We hope by this to stimulate a community sentiment in whoever starts using what we have produced.

Thanks for your consideration; please let me know if you have any questions,

In case you're interested in publishing your tree collection on the net, I
would be happy to include your plants, species, coordinates to
http://gardens.ghini.me. Georeferenced textual information panels are also
very welcome, all offered as a courtesy: We're still defining the offer.
The idea behind this is allowing visitors to explore aggregated garden
collections, and the current focus is on trees.

A small example: http://gardens.ghini.me/#garden=Jardín%20el%20Cuchubo

Mario Frasca MSc


[1] http://ghini.readthedocs.io/ - http://ghini.github.io/

[2] https://play.google.com/store/apps/details?id=me.ghini.pocket

[3] http://gardens.ghini.me/

[4] https://play.google.com/store/apps/details?id=me.ghini.tour

[5] https://hosted.weblate.org/projects/ghini/#languages

[6] https://www.youtube.com/playlist?list=PLtYRCnAxpinU_8WEDuRlgsYnNVe4J_4kv





free botanic data management systems

Many institutions still consider software an investment, an asset that is not to be shared
with others, as if it was some economic good that can't be duplicated, like gold.

As of right now, very few copylefted programs exist for botanic data management:


	ghini.desktop, born as bauble.classic and made a commons by the Belize Botanical
Garden.  ghini.desktop has three more components, a pocket data collecting Android app,
a Node.js web server, aggregating data from different gardens and presenting it
geographically, again a geographic tour app aimed at visitors using the web data
aggregator as its data source. You can find every Ghini component on GitHub:
http://github.com/Ghini


	Specify 6 and 7, made a Commons by the Kansas University. A bit complex to set up,
very difficult to configure and tricky to update. The institutions I've met who tried it,
only the bigger ones, with in-house software management capabilities manage to successfully
use it. They use it for very large collections. Specify is extremely generic, it adapts
to herbaria, seed collections, but also to collections of eggs, organic material, fossils,
preserved dead animals, possibly even viruses, I'm not sure. It is this extreme
flexibility that makes its configuration such a complex task. Specify is also on GitHub:
https://github.com/specify and is licensed as GPLv2+.


	Botalista, a French/Swiss cooperation, is GPL as far as rumours go. Its development
has yet to go public.


	bauble.web is an experimental web server by the author of bauble.classic.
bauble.classic has been included into Ghini, to become ghini.desktop. Bauble uses
a very permissive license, making it libre, but not copylefted. As much as 50% of
bauble.web and possibly 30% of ghini.desktop is shared between the two projects. Bauble
seems to be stagnating, and has not yet reached a production-ready stage.


	Taxasoft-BG, by Eric Gouda, a Dutch botanist, specialist in Bromeliaceae, collection manager at
the Utrecht botanical garden.  It was Mario Frasca who convinced Eric to publish what he was doing,
licensing it under the GPL, but the repository was not updated after 2016, April 13th and Eric
forgot to explicitly specify the license.  You find it on github:
https://github.com/Ejgouda/Taxasoft-BG


	BG-Recorder, by the BGCI, runs on Windows, and requires Access.  Developed mostly between 1997
and 2003, it has not been maintained ever since and isn't actively distributed by the BGCI.  I've
not managed to find a download link nor its license statement.  It is still mentioned as the free
option for botanic database management.




Of the above, only ghini.desktop satisfies these conditions: Copylefted, available,
documented, maintained, easy to install and configure.  Moreover: Cross platform and
internationalized.



Welcome to Ghini/Bauble

Dear new user,

Welcome to Ghini/Bauble.

As the maintainer, I have received your registration for bauble.classic/ghini.desktop,
many thanks for taking your time to fill in the form.

I see you are using bauble.classic-1.0.55, whereas 1.0.55 is the last released version of bauble.classic, however,
bauble.classic is now unmaintained and superseded by the fully compatible, but slightly aesthetically different ghini.desktop. Install it following the instructions found at http://ghini.rtfd.io

The registration service says you're not yet using the newest Python2 version available. As of 2018-05-01, that is 2.7.15. Using any older version does not necessitate problems, but in case anything strange happens, please update your Python (and PyGTK) before reporting any errors.

Also thank you for enabling the "sentry" errors and warnings handler.
With that enabled, Ghini/Bauble will send any error or warning you might encounter to a central server, where a developer will be able to examine it. If the warning was caused by an error in the software, its solution will be present in a subsequent release of the software

If you haven't already, to enable the sentry and warnings handler, open the ":config" page in Ghini and double click on the row "bauble.use_sentry_client".

I hope Ghini already matches your expectations,
if this is not the case, the whole Ghini community would be very thankful
if you took the time to report your experience with it.

The above is one way to contribute to Ghini's development. Others are:
- contribute ideas, writing on the bauble google forum (https://groups.google.com/forum/#!forum/bauble),
- contribute documentation, or translations (https://hosted.weblate.org/projects/ghini/),
- give private feedback, writing to ghini@anche.no,
- rate and discuss Ghini openly, and promote its adoption by other institutions,
- open an issue on GitHub (https://github.com/Ghini/ghini.desktop/issues/),
- contribute code on GitHub (fork the project on (https://github.com/Ghini/ghini.desktop/),
- hire a developer and have a set of GitHub issues solved, per-haps your own
- let me include your garden on the still experimental worldmap (http://gardens.ghini.me)

I sincerely hope you will enjoy using this copylefted, libre software

Best regards,
Mario Frasca

https://ghini.github.io
https://github.com/Ghini/ghini.desktop/issues/



Do you want to join Ghini?


注釈

I generally send a note similar to the following, to GitHub members who "star" the project,
or to WebLate contributors doing more than one line, and at different occasions.  If it's from
GitHub, and if they stated their geographic location in their profile, I alter the letter by first
looking on institutos botánicos [http://umap.openstreetmap.fr/en/map/institutos-botanicos_470